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How do | create a S5-compatible communication with the services FETCH
and WRITE to the SIMATIC S5 for the SIMATIC NET OPC server over
Industrial Ethernet with the SIMATIC NET PC software?

Answer

The instructions and notes listed in this document provide a detailed
answer to this question.
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Assignment of tasks

In this example, a commercially available network adapter is used that
implements the S5-compatible communication with the services FETCH
and WRITE over the OPC server to the S5 station.

The method described in these instructions also applies to the CP1613,
CP1623, CP1512 and CP1612 communication processors.

Condition

It is assumed that one of the two following configuration tools is installed:

e NCMPC
NCM PC is supplied with the SIMATIC NET CD and allows you to
create PC projects and open STEP 7 projects. It is, however, not
possible to edit S7 blocks in the STEP 7 project with this software.

e STEP7
STEP 7 is a separate software package with which you can create S7-

400, S7-300 and PC projects. S7 blocks can be edited with this
software.

Only one of these tools can be installed.

In chapter 2 “Configuration of the PC station” is described the configuration
of PC station so that you can use the S5-compatible communication with
the services FETCH and WRITE over Industrial Ethernet to exchange data
between PC station and S5 station.

V1.0
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2 Configuration of the PC station

After successful completion of the hardware and software installation of the
SIMATIC NET CD and the configuration tool and after restarting your
computer, you start NCM PC or STEP 7 with "Start - (in Windows XP: All
Programs->) SIMATIC - SIMATIC Manager or SIMATIC NCM PC
Manager or using the desktop icon of the same name.

Create a new project with "File > New".

Figure 2-1 giving the project a name

New Project x|

Uzer projects |

N ame | Storage path
@ Example F\Program Files\SIEMENSASIMATIC NCMAS 7piosE xample

Copyright © Siemens AG 2008 All rights reserved
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a | 2|
Mame: Type:
|F’E_Slatiu:ur| I Praject d
Jil it
Storage location
|:'\Prugfam Files\SIEMENSA\SIMATIC MCMA\S Ppinj Browse... |

cos | |

Confirm the project name you have entered (in the example: "PC_Station")
with OK. An empty STEP 7 or NCM PC project is then created.

V1.0 03.03.2008 5/34
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Figure 2-2 inserting the PC station

[ SIMATIC NCM PC Manager - PC_Station | =10] x|

File Edt Insert PLC ‘View Options Window Help

DIc[8? (86| sa| 2of || ] [<Norae ~1%] 28| BE(m| Al

IZ7 pC_Station -- C:\Program Files' SIEMENS!, SIMATIC.NCM\S 7proj\PC_Stati o =] |

[=X[SIMATIC PC St

Press F1 to get Help. [ IcPss11(MPT) [ y
With the menu command "Insert - Station > SIMATIC PC Station", you
insert the PC station.

Figure 2-3 changing the name of the PC station

3 siMATIC NCM PC Manager - PC_Station =10l x|

File Edit Insert PLC View Options Window Help

089 & (Gl s 2af> s(] ] [<nore =z %8 =Em| x|

'ET" PC_Station -- C:\Program Files', SIEMENS' SIMATIC.NCM\STproj\PC_Stati

Press F1 ko get Help. | |CPSA11{MPI) |

V1.0
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Give the PC station you have just inserted the same name as your
computer (in the example: "PC_Station").

Now open the hardware configuration of the PC station by selecting the PC
station, then pressing the right mouse button and selecting "Open Project"

(STEP 7: "Open Object").

Figure 2-4 hardware configuration of the PC station

[Ei2 SIMATIC NCM PC Config - [PC_Station (Configuration) — PC_Station] =10 x|
O Station Edt Insert PLC View Options Window Help =& x|
D[22 %] & ve| wlu(@b %8 el
—_— il oix|
= End | ||
4 el
5 PROFIBUS-P4,
6 + PROFINET 10
z | -8, SIMATIC PC Station
K ;I_‘
o
index | [] Module Order number Fim.. | M..| C..
1 =
2
3
i |
5
6
7
) PROFIBUS-DP slaves for SIMATIC 57, M7, and C7 E
3 (distributed rack) i
10 M|
Press F1 ko get Help. . = I [

You will see an empty rack. If you cannot see the hardware catalog, click

on the button marked in red.

V1.0
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Figure 2-5 selecting the modules from the hardware catalog

E;ES]MA‘IIE NCM PC Config - [PC_Station (Configuration) — PC_Station] =] F
Bl Station Edt Insert PLC Yiew Options Window Help |8 x
D8 %] g =] b« [me] 28
= [~
3= o
ijl End | atjay
4 5 % PROFIBUS DP
cJ 3% £ROFIBUS-PA
3 =38 PROFINET 10
i =l = B SIMATIC PC Station
o

=1 CP Industrial Ethemet
— e CP 1411
L’_’ #-] CP1413
-1 CP1511

m-{3 CP1512
-1 CP1B12

@] CP1613
Index Module Order number Fim.. | M..| C.. 211 JE General
1 I
2
: |
: = Q
#={
3 IE_CP ¢
Substitute for any Industrial Ethernet module, PROFINET ——
10 &l [la} ller, IS0, TCP/IP, S7 connections, PG funclions,
1 ||routing, SIMATIC NET CD 11/2003SP1 ...
Press F1 to get Help, ]

Now place your PC modules in this rack (for example by dragging them
from the hardware catalog).

If you use a CP1613 (or CP1612 or CP1512) you will select the CP1613 (or
CP1612 or CP1512) instead of IE General.

The following dialog appears automatically after you insert the module in
the PC station.

V1.0
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Figure 2-6 address assignment dialog

Properties - Ethernet interface IE General (R0O/59) L

General  Parameters |

1%

¥ | Set MAE addiess L use |50 protocal

_ T TS If & subnet it selected,
MAC address: {08-00-06-24-E0-B7 the next available address i suggested.

[~ IP protocol is being used

IP address: [132168.01 Gateway-
% [o ot use router
Subriet mask: | 255,255 265.0 -
& l_l sErouter
Address:  |132168.07
Subnet:

ok | Cancel | Hep |

Copyright © Siemens AG 2008 All rights reserved
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Select the check box ,.Set MAC address / use 1SO protocol”. Following
deselect the check box ,IP protocol is being used.

Enter the MAC address of the Ethernet network card.

Click on the button “NEW” to add a new Industrial Ethernet network. The
following dialog appears automatically.
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Figure 2-7 setting up an Ethernet network in STEP 7 or NCM PC

Properties - New subnet Industrial Ethernet x|
Geneial ]
Name: Ethemet(1]
57 subnet ID: |EIEIJ5 . |IJEIIJ3
Storage location
il [C\Program Fies\SIEMENS\SIMATIC NCMAS 7propPC,_Sta
Author, [
Date created: 25.01.2004 14:23:54
Last modified: 25.01.2004 14:29:54
Comment: ;I
Cocd | Heb |
Confirm the dialog with ,OK".
Figure 2-8 fully configured network adapter
Properties - Ethernet interface IE General (R0/59) ) x

General  Parameters |

F set MAC address /use 150 protoco!

MAC address: |06-00-06-24-E0-B7

™ IP protocol is being used

IP address: J192168.01

Subnet mask: |255.255.255.0

If & subnet is selected,
the next available address is suggested.

- Gateway
* Do notuse router

€ [se router

Addess:  [15276207

| Ok |

The network adapter is now fully configured and networked. Confirm the

configuration with OK.

V1.0
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Figure 2-9 network adapter placed in the PC station

Entry-ID: 16697502

:_L:’-S[MA'IIE NCM PC Config - [PC_Station {Configuration) -- PC_Station] ;Iglll
O Station Edit Insert PLC Wiew Options Window Help NETES
D[22 (% 8 e bl @] 28 x|
= olx|
|
P gt | atla
4 PROFIBUS DP
5 PROFIBUS-PA
6 ¥ PROFINET IO
7 =8, SIMATIC PC Station
8 =1 CP Industial Ethemet
s [ EGeneal = cPun
4 _rﬂ ] CP1413
KN ¥ ® 1 cP1sh
@ (1 cPi1siz
=0 Pc (1 CP1612
: @ ] CP1613
Index Module Ordler rumber Firm... | M...| C.. 553 IE General
1 - L SWVE2
- SWVB25P1 .
3 #-{Z] CP PROFIBUS
4 L 0 HMI
: {1 User Application
7
IE_CP T
!ﬂ: |E General lIE_cP 6.21 f’n“bmllulgg I?gJP?PIBIE;W module, p?m
a | ] |routing, SIMATIC NET CD 11/2003 SP1 .
Press F1 to get Help. cha

The module is now placed on a PC slot.

Figure 2-10 configuring the OPC server

[ SIMATIC NCM PC Config - [PC_Station (Configuration) — PC_Station]

@y station Edt Insert PLC Wiew Options ‘Window Help

=18ix]

=18 x|

Di(e-B (% &) Ble| dblul[@o] 8wl

4
E
E
7

#E IE Genesal

[~

R

iIE‘nd: [ ﬁi.;[

=] CP Industrial Ethernet |
(] CP1411
-] CP1413

.. SWVE.2
SWWVB2SP1 ..

o

Index | [§ Module

Order number

Fimware

MPI ..

1

[l OPC Server

ai: IE General

= =TT
‘awlw-\lm ~

Insertion possible

-] CP PROFIBUS
2 HMI
=23 User Application
-] Application
=] OPC Server
] . SWVEOSP4
§ swveDSPS...
q swvel..
] SwVB25P1 ..

1 EAEEN

|2 14

OPC Server -
OPC Server for the DP, FDL, FMS, 57
different subnets), ISO/TCP, SNMP,
DP master class 2, PROFINET CBAAD, :I

s

[ <
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Select the OPC server in the hardware catalog and then drag it to any slot.

Figure 2-11 button ,NetPro*

D[22 (% @ w2 sl @)

Now open the NetPro program. Use the button marked red in the toolbar in
Figure 2-11 button ,NetPro“.

In NetPro you configure connections to exchange data between OPC
server and S5 station.

Figure 2-12 configuring the S5-compatible communication in NetPro

E‘_}%Netpro - [PC_sStation {(Network) -- C:\Program Files\...\STproj\PC_Stati]

N [=]F
B2 petwork Edit | Insert PLC Wiew Options Window Help mI=ES
= 2 QHI g Metwork Objects Ctri+G g ! E] |
[~ wieT ection,..,  Crrl4+M =] ol x|
End | t{anif
- Selection of the network
[+ 3 PROFIBUS DP
£ PROFIBUS-PA
[+ B¢ PROFINET 10
- Stations
-] Subnets

] 1

Local D Partner ID [partner Type

L
_lj PROFIBUS-DP slaves for SIMATIC J
»

57, M7, and C7 (distibuted rack)

< |

Inserts a new connection in the connection table, PCinternal {local) [x 171 ¥ 0

h

Select the OPC server. Right-click the OPC server = "Insert - New
Connection“or use the menu ,Insert > New Connection“to insert a new
connection.

V1.0
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Figure 2-13 dialog ,Insert New Connection“

Insert New Connection ﬂ
- Connection Partre: -
[= £| Ir the cument project
= &P PC_Station
v [Unepecified)
- fill broadcast stations

e Bl uticast stations
& I urknown project

connechon

F Displai properties before meerting

ok | eel Cancel | Hep |

Because the communication peer isn’t configured in the same S7 project
like the PC station, as in this example, an unspecified connection with the
type 1SO transport will be configured. Select “unspecified” for
communication peer in the dialog box.

Confirm the dialog with ,,OK*. Now the property view of the ISO transport
connection will open.

V1.0
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Figure 2-14 property view of ISO transport connection - register ,General”

propertes - 150 transport comection
General Information |  Addresses | Options| OPC | Overview |
— Local Endpoint

Hame [ID} “ISD-Fetch I

ViaCP:  |IE Genesal

|

Rowe.. |

Estab, Detals.. |

Concel |  Hep |

In the property view - register ,General“you can enter a name, choose by
yourself, for the ISO transport connection. Enter this name in the text field
.Name (ID) “, for example ,|ISO-Fetch”. Select the check box ,Active
connection establishment®.

Change into register ,Addresses".

Figure 2-15 property view of ISO transport connection > register ,Addresses"
x
General Information  Addresses | Options| OPC | Overview |
Local Remote
MAC (HEX} 08000601087 (0800060144 FE |
TSAP (ASCIE ﬂPCFErcss ] (ssercec )

TSAP (hex) [50.4346.4554.435335  [53.35.46.45.54.43.50.43

TSAP length: 8 8

03.03.2008 14/34
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Enter the MAC address of the communication peer. The TSAPs are used to

identify the 1SO transport connection between the PC station and S5
station.

NOTE The address information of the created connection must be included in
the connection configuration at the S5 end.
Change into the register ,,Options*.
Figure 2-16 property view of the ISO transport connection - register ,Options*
x|
General Information ] Addresses  Uphions | oPC I Owerview ]
Local
Mode: u-Fetch active ﬂ]
I™ 57 addressing mode
Cace_| _ts
Select the mode ,Fetch active®.
Confirm the dialog with ,,OK".
Insert a further unspecified ISO transport connection for the OPC server
with the following properties.
V1.0 03.03.2008 15/34
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Figure 2-17 property view of the ISO transport connection - register ,General*

x
General Information l Addresses IEIphmsI EIF’Cl Elvﬂwiewl
Local Endport

Mame [ID]: ‘ 1S04write I

Via CP: ]IE General

Boute... |

(~ Bcive connection estabiishment |
Estab. Detais... |

cot | e

In the property view - register ,General” you can enter a name, choose by
yourself, for the 1ISO transport connection. Enter this name in the text field
.Name (ID) “, for example ,ISO-Write”. Select the check box ,Active
connection establishment®.

Change into register ,Addresses".

Figure 2-18 property view of the ISO transport connection - register ,Addresses"

Properties - IS0 btransport connection ; EI

GeneralInformation  Addresses | options| OPC | Overview |

Local Femote
MAC (HEX} 08000601087 (os000s01-48FE )
1saPasoly  fPcRecvss ) W]
TS&P [hex] [50.43524543565335  [53.355245.43.56.50.43
TSAPlength: 8 8

V1.0 03.03.2008 16/34
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Enter the MAC address of the communication peer. The TSAPs are used to

identify the 1SO transport connection between the PC station and S5
station.

The address information of the created connection must be included in
the connection configuration at the S5 end.

Change into register ,Options".

Figure 2-19 property view of the ISO transport connection - register ,Options*
Properties - ISO transport connection x|

General Information | Addresses  Options | OPC | Overview |

Local
Mode: l Wribe active ﬂ I

Corcel |t

Select the mode ,Write active“.
Confirm the dialog with ,OK*.

If you select the OPC server in the SIMATIC PC station, the created
connections will be displayed in the connection table.

V1.0
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Figure 2-20 Angelegte Verbindungen in NetPro
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iiENetPro - [PC_station (Network) — C:\Program Files\,..\STproj\Pi i =]
88 petwork Edit Insert PLC Yiew Options Window Help -8 x
(@ (% @ [0 il 8] o2 B[z K
PC_Station

Ethernet{1)

Industrial Ethegnet
| | A
Local D [Partrer 0 [Partner [Type -
ISO-Fetch i Unkrowvn i 120 transport connection =]
ISO-Write | Unknowwn IS0 transport connection .
4 | »
Ready PC internal (local) [1 from 2 selected [CI

Now the configuration of the ISO transport connections with the services
FETCH and WRITE is finished. You have to save and compile S7 project.
Therefore select the PC station in NetPro and click the button ,Save and
Compile” in the toolbar. This updates the information in the S7 project.

Figure 2-21 Save and Compile

x

~ Compile
+ Compile and check everything
" Compile changes only

0K Cancel | Help

V1.0 03.03.2008
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Warning indications can be displayed while proceeding with the “Save
and Compile” of a S7 project. Warnings serve as piece of information and
have no functional effect. In case error warnings occur, search for
possible divergences in the previous steps of the instructions.

After the configuration is finished successful you have two possibilities to
download the configuration on the PC station.

Configuration and download from STEP7 or NCM PC

With this function it is possible to perform a configuration completely from a
remote computer, if a network connection (standard Ethernet) to the target
PC station is available. It is assumed that the PC station can be reached

via network connection. The project engineering can be downloaded after
that.

Configuration and Download via “Import Station”

With this function it is possible to download the configuration and project
engineering at once also without a connection to the target PC station.
Depending on the application, other configurations can be loaded.

Open the ,Station Configuration Editor* in the Windows START Menu >
,Station Configuration Editor* or with the following button in the Windows
task bar.

Figure 2-22 button ,Station Configuration Editior*

=)

V1.0
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Figure 2-23 Station Configuration Editior

Station Configuration Editor - [OFFLINE]
Components | Diagnostics | Configuration Info |

Station:  |PC_Station Mode: RUN_P

Index | Name | Type | Ring | Status | Run/Stop | Conn | 4|

. -
A el AL ALY —

F*Iew diagnostic entry armyved!

Add.. | Edit | Delete. | ila T

Station Name... | { Impot Station... ) Disable Station

[ ] _ b

Click the button "Import Station...“. A message about restarting the PC
station will open.

Figure 2-24 message about restarting the PC station

Station Configuration Editor _E]

- The station will be restarted.
& - b ake sure that no communication iz active over the
components invalved.

Do you wark ko import the station?

V1.0 03.03.2008 20/34
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Confirm the message about restarting the PC station with ,Yes". The
following dialog to select the XDB file, which should be import, opens.

Figure 2-25 selecting the XDB file

21
Lookin: [ £ #DBs x| €« @B ex -
= (&} Desktop ]
Spest_ L) My Documents
¢ My Computer
M 3% Floppy [&)
< SYSTEM (C:)
I Program Files
I SIEMENS
1) SIMATIC.NCM
1) 57proj
) PC_Stati
Fh ﬂdﬂJ - :':::l::' E: 8 ﬁm
< DATA (D:) Cancal
Flesoft o windk () El|| e

In this dialog you enter the path of the XDB file. The XDB file is always
created in the project by NCM PC / STEP 7 (see Fehler! Verweisquelle
konnte nicht gefunden werden.). With the combo box ,Search in: “you

navigate in the path of the XDB file.

V1.0
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Figure 2-26 information from the XDB file

x
Index i Marme | Type | S!ﬂ!usl E mor |;|

2 ] OPC Server OPC Server

9 '-?E: IE General IE General

@ The XDB mport is possible. Refer to the list abowve for the configuration.

™ Woaik in offline mode [a download to this station iz then not possible]

As information, you can see once again which modules and applications
are configured in the XDB file.

V1.0
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Figure 2-27 PC station is configured
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Station C Editor - [ONLINE x|
Components | Diagnastics | Configuration Infa |
Station:  PC_Station Mode:  RUN_P
Index | Mame | Type | Ring | Status | Run/Stop | Conn | =
1
2 [] oPCServer OPC Server = v i
3
4
5
5
7
8 —
3 F IE General IE General 5! ©
10
1
12
13
14
15
16
12 =
Mew diagnostic entry anived!
Add | Ed | Delete | Anaol |
Disabls Station
_ x| _ e |

Now the import of the XDB file is finished and the configuration is

downloaded.

In the column connection, which is marked red, you see that the connection

is also been downloaded.

Now the configuration of the PC station is finished.

V1.0 03.03.2008
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3 Configuration of the SIMATIC S5

3.1 Initialization of the CP 1430 and configure the S5-compatible
communication with the services FETCH / WRITE

Start STEP 5 in the Windows START Menu "Start - SIMATIC - STEP 5
- STEP 5.

Press the "F9" key to change to the configuration tool of the CP 1430
"SINEC NCM COM 1430".

NOTE The "SINEC NCM COM 1430" configuration tool is additional software
integrated in STEP 5 to configure the CP 1430. This software is not
included in the standard STEP 5 package and must be ordered
separately. Initialize the CP using the "Edit > CP_Init" menu.

Figure 3-1 Initializing the CP

COM 14
CP Basic Initialization Source: GC:ABABSI (OFFLIME}

MAC address (HEX> Ol W26 1AAFE
SIMATIC details

Base SSHR : @

Interface
communication (Pr /B> : P
S2NR offszet : A

Copyright © Siemens AG 2008 All rights reserved
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Informative parameters:

Card type H Database size
Hodule ID :  CP1438TF

Firmware version H Date created
Plant designation

The MAC address of the CP 1430 must match the MAC address configured

in NetPro (see Figure 2-15 property view of ISO transport connection -
register ,Addresses").

The Base SSNR specifies the CP in the rack. This interface number must
be used in the block calls in the S5 program.

Apply the settings with "F7".

V1.0 03.03.2008 24/34
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Open the "Edit - Connections - Transport Connections" dialog.

Figure 3-2 creating a connection with the service ,FETCH"

COM
Transport Connection Source: C:AFAQFEWR C(OFFLIME)

SSHR offset 5 ANR

Job type 3 Activefpassive (ASP) :(:]

Friarity : Read/write (¥/H) :@

Transport addresses:
Loc. parameters: Rem. parameters:

MAC address (H =
TSAP (Ase) :{i393309¢) TSAP (Ase) :{gdaarssy
TSAP CHEX) : EEREERCTRL G i LE TSAP CHEZ) : g !
TSAP length: TSAP length:

e Enter "FETCH" for the job type and enter ,P“for passive.

¢ Inthe local parameters, enter the remote TSAP which is defined in
NetPro for the 1ISO transport connection with the service “FETCH” (see
Figure 2-15 property view of ISO transport connection - register
»LAddresses").

Copyright © Siemens AG 2008 All rights reserved
Guideline_FW_S5_e.doc

¢ In the remote parameters, enter the MAC address of the network card
in the PC station and the local TSAP, which is defined in NetPro for the
ISO transport connection with the service “FETCH” (see Figure 2-15
property view of ISO transport connection - register ,Addresses").

Create a second connection with ,F3“.
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Figure 3-3 creating a connection with the service ,RECEIVE"

COM 1430 TF4%:
Transport Connection Source: C:AFAQFEWR COFFLIME)

SSHR offset : AHR

Job type 3 Activefpassive (AFP) : |j

Priority = Read/write (Y/H)

Humber of jobs per TSAP . | of |

Transport addresses:
Loc. parameters: Rem. parameters:

TSAP CASCY = €RL1T4LEA) TSAP CASCY = {
TSAP CHER) : FEREESEFALLIL 5 Gl TSAP CHEX) :
TSAP length: [ TSAP length:

e Enter "RECEIVE" for the job type and enter ,P“for passive.

¢ Inthe local parameters, enter the remote TSAP which is defined in
NetPro for the ISO transport connection with the service “"WRITE” (see

Figure 2-18 property view of the ISO transport connection - register
~Addresses").

¢ In the remote parameters, enter the MAC address of the network card
in the PC station and the local TSAP, which is defined in NetPro for the
ISO transport connection with the service “WRITE” (see Figure 2-18
property view of the ISO transport connection - register ,Addresses").

Apply the settings with ,F7*.

Following download the configuration with , Transfer > FD - CP*“in the
CP1430. To start the loading of CP1430 you have to stop the CP1430:
CP-Function - stop.

Return to the STEP 5 configuration dialog with "File > Exit" and "ESC".

Description of the S5 program

Synchronization of the CP 1430 with the CPU using the SYNCHRON call in the
start-up OBs

Insert the following start-up OBs in the STEP 5 project:

e OB20
e OB21
e 0OB22

In these OBs, program the FB125 "SYNCHRON" call that synchronizes the
CPU and CP.
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Figure 3-4 call the FB125 ,SYNCHRON*

A ISTEP 5
0B 20
Segment

Hame
SSHR
BLGR
PRAFE

-
-
-
=
=
=
=
=
-
-
-

Calling the block ,SEND_ALL"and ,RECEIVE_ALL"in the OB1
Create the OB1.

Program the call of the block FB126 ,SEND_ALL“and FB127
-RECEIVE_ALL".

Save the OB1 with F7.

Creating the send and receive buffer

Since the send and receive buffer is located in DB10, this must be created
in the project and declared with an adequate length. Then download the
entire program to the S5 station.
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4 Establish the connection with the OPC Scout

Start the OPC Scout with "Start - SIMATIC - SIMATIC NET - OPC
Scout".

Double-click the ,OPC.SimaticNet“for connection with the SIMATIC NET
OPC server. In the dialog that appears, enter a suitable group name and
confirm this with OK.

Figure 4-1 connecting with the OPC server and enter a group hame

[E]0PC Scout - New Project1

File ‘iew Server 7
e [ | | | e |
&) M| & X
|Servers and groups lltems incl. status infoimation
= g Serverls] Item Names Value |
=& Local Servers) 1

=45 OPC SimaticNET
\Q [Hew aroup)
&0 Eladdc X
3 G x|
E P 1 Group Properties:
L 1

22 Remc | Enter a Group Name"

My A

[sR

Create new group active v

Reguested update rate m ms ISE":I j
[ Extended oK Cancel | Apply |

| Successfully connected ta: ‘0PC SimaticNET

Double-click the OPC group which you have created. The "OPC-Navigator"
opens. You will now see your protocols in the OPC Navigator. Double-click
on "SR". The connection name you configured in NetPro appears.
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Figure 4-2 OPC-Navigator

Hodes
=& Connections
=4 \SR:
=[] 150-Fetch
F-] 150MWiite
=+ #h \SHMP:
= @& “FOL;
+ ¢4 \DP:
= @ \FMS:
+ @& ‘\DP2
+ ¢ ST

Lol Fovarzion I.
2 bwinzockversi. SA:

Kl sl

|\SF: is selected

Entry-ID: 16697502

Double-click the configured SR-connection with the name “ISO-Fetch”. Two
items appear in the middle window. Move one of the two items to the right-
hand window with the button "->". Double-click the Item in the right-hand

window.
Figure 4-3 defining a new OPC item in the OPC Scout
2 OPC-Navigator = i =
Nodes Eanine I Item Nam... | The listed Item(s] will be added to
= E Connections 3 Btdepdhl] sn[lsu_ 5R: kstatepath{]
88 \SR: 2 tstatepathval]  SR:(ISO-...
= 150Fetch
[+ il aliases
. S x
& 8% SNMP: Elmodify an Item x|
[+ & ‘“FOL: Enter an item with the following Syntax:
+ @& \DF: .
= g \FMS: [Devicename]ltemname
@ @& \DPZ SISO Fetchlistatepathi]
+ @& \S7:
Modify Item Cancel |
Enter an ltem
Eilter | DK I Cancel
5.1 S| B | |
|ISD-Fetch is selected |26.06.2003| 1252
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In this example, the send area of the CPU is located in DB10. DB10 must
be created in the S5 station with an adequate data length. The item for
writing from the PC to the CPU is declared as 5 words in DB10 starting at
word 0. Click on "Modify Item".

Following dialog appears:

Figure 4-4 modifying name of item

x
Erter an itern with the following Syntas:
[Devicenamejitermname

|SR:[150-Fetch]DB10:WORD0.5

Madify [bem Cancel

[Entes anltem

Double-click the SR-connection with the name ,ISO-Write“in the OPC
Navigator. Two items appear in the middle window. Move one of the two

items to the right-hand window with the button "->". Double-click the Item in
the right-hand window.

Figure 4-5 defining new OPC items in the OPC Scout

[EJopc-Navigator T ik x|
Nodes _ [ Leaves [ itemNam...| The fsted ltemi) vl be addd to
= 8 Connections © tstatepath(]  SR:[ISO-... LAY AN
581 \SR: O totatepathval) SRS e
=14 I50-Fetch
[+ ¢ aliazes
e [ T 1
« & \FOL: Enter an item with the following Syntax:
=@ \DP: :
© @& \FMS: [Devicename|ltemname
= @4 \DPZ |5H:[|suwnta]&staxepath[]
@l ST
| Modify Item I Cancel |
[Variable Added/Modified
Eilter " oK I LCancel
K limcmmsoll| 1|
[1SOMriteis selected  [6062003[ 1254

In this example, the receive area of the CPU is located in DB10. DB10 must
be created in the S5 station with an adequate data length. The item for
receiving CPU data is declared as 5 words in DB10 starting at word 0. Click
on the button "Modify Item". Following dialog appears.
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Figure 4-6 modifying name of item

Evoity neem
Enter an item with the following Syntax:

[Devicenamelltemnams

iEﬂ:[iSGWli!E]EJE‘iIlW_ D05

h-'I

&

ltem Cancal

IVanable Added/Modified

Exit the dialog with ,OK”.The items are adopted in the OPC Scout. If the
quality of the first item is good, the SR-connection with the service “Fetch”
to S5 station is established.

Figure 4-7 OPC Scout

(RN = S S e i

| 6 & & 417 o] 4]

Servers and groups [Items incl. status information
e g Sevels) 0 | Item Names | Value | Aci Quality
= S Local Serverls) 1 |SR[IS0FetchDB10WORDOS {1011111101010} A good
) 8 OPC. SimaticNET 2 |SR:IS0write]DB10MWORDOS W bad
SR 3

[Mew group)
& OPC.SimaticMET.DP
& OPC.SimaticNET.PD
& OPCServer.WinCC
= 22 Remote Serverls)

My Add Remate Servers(

Double-click on the box “value” of the OPC item ISO-Write to write values
into the PLC of the S5 station.
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Figure 4-8 writing values
fltems incl. status information
| Item Names | Value | Access ﬁualit'_'.t Write

5= ] Write ¥Yalue(s) to the Itemi(s) _ ﬂ

Yalue

ERERITAY.

— Formatconversion———— £ S v
(" Onginal " Async wite
Cadl
C B
B S o AN Ok Cancel Apply

NOTE If the number of values entered does not match the declared area of five
words, the values cannot be written to the S5 station.

Successful sending of values to the S5 is displayed in the "Write Result"
and "Error" columns of the OPC Scout. The "Write Result" and "Error”
columns can be made visible in the "View - Options" menu.

Figure 4-9 successful sending of values
Item Names Value |[Wual Write Result Error
SH ISﬂ Fetch DBII]WEIHDD’S 111171 1)00010} qood

1= 1'|_|Fe.'r'|'|' completed succ exsf

NOTE The quality of the OPC item “ISO-Write” remains constantly set to invalid
because the connection is a one-ended write connection. The quality of
the connection can not be checked.
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5 Basic configuration instrutions
5.1 TSAP rules
o The length of the TSAP is 8 signs.
e The characters permitted for TSAPs are letters, numbers, hyphens, and
underscores.
e Use upper case letters.
e The local and remote TSAP can bet be same.
e The TSAPs must be unigue per connection.
e To check the TSAPs, use the output of the character string in
hexadecimal format.
5.2 Interface number (SSNR)
e The interface number of the CP is assigned in the configuration tool of
the CP1430 ,SINEC NCM COM 1430“in the dialog “Edit > CP Init).
e The SSNR must be specified as a parameter in all communication
blocks of the CPU (FB120, FB121, FB125, FB126, and FB127).
e The interface number must be divisible by 4 (0, 4, 8, 16...).
5.3 FB126 ,SEND_ALL“ und FB127 ,RECV_ALL"“, FB125
» OYNCHRON*
e The PAFE and ANZW parameters are output parameters. These are
used for diagnostics and job monitoring.
e The blocks must be called using unconditional calls (for example JU
FB126).
V1.0 03.03.2008 33/34



Copyright © Siemens AG 2008 All rights reserved

Guideline_FW_S5_e.doc

SIEMENS

FETCH/WRITE to S5 over IE

Entry-ID: 16697502

6 History
Version Date Changes
V1.0 03.03.2008 | First Issue
V1.0 03.03.2008 34/34




